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GABS

10 x 50W Class D 7.3 /5.3
Configurable Audio Amplifier Board -
TPA3244

The GABS8 is a compact and powerful audio amplifier board that is
designed for game machine applications with a total output power of
500 watts (10 x 50 W).

Features:

+ 7.1 USB UAC2.0 Codec as Audio Input.

+ Versatile Output Modes: Choose from 7.3 or 5.3 Configurations.

« Supporting External Plug-and-Play Modules as Daughter Boards.

+ Higher Output Power to 75W Peak with Fan Installed and DC 24V Supply.

Parameters:

Supply Voltage (15V to 30V) Mini-Fit Jr 2x2 CKT System Audio 7.3 /5.3 System

Output Channel Mini-Fit Jr 2x7 CKT Audio Input USB Type-C

Output Power 50W peak per Channel without Fan Product Size 152.40 (w) x 114.30 (d) x 28.60 (h) mm
Installed Weight 443¢g

Audio Output

Audio Output

Power Supply

{ - Min 24V, 200W
Control Connector s y A

Fan Connector

USB Type-C Audio

Mechanical Drawing
(Nominal Dimensions, mm)

28.50

NOTE: The GAB8 amplifier comes with a standard 15mm fan.
Upon customer request, a 10mm fan is available at an additional
cost of $1.57.

Specifications are subjected to change without any further notice. Copyright © 2023 by Wondom Audio Technology. All rights reserved.
For more information please visit www.wondom.com
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Precautions
Safety Precautions

Start by thoroughly reading the user manual provided with your GAB8 amplifier.
It contains essential safety information and guidelines specific to your device.

+ Check that the impedance (ohms) of your speakers matches the GAB8's requirements. Using speakers with the incorrect impedance can
damage the amplifier or speakers.

+ Be cautious with volume levels, especially when testing or initially setting up your system. Sudden loud sounds can harm your hearing and
potentially damage your speakers.

+ Ensure that GABS8 is properly grounded and connected to a stable power supply. If you are not going to use GAB8 for a long time, be sure
to disconnect GAB8 from the power supply to prevent any damage or energy wastage.

« If you have children, secure or place the amplifier out of their reach to prevent accidents and potential damage.

c CA UTION Indicates a potentially hazardous situation which, if mishandled, could
result in moderate or minor personal injury, and/or property damage.

Installation Precautions

+ Organize and secure cables to prevent tripping hazards and accidental disconnections. Use cable clips or ties to keep wires neat and tidy.
+ Place GAB8 securely on a stable surface. Serious damage to this product may result if it falls. Do not allow anything to rest on the GABS.
Do not place GAB8 where a person can step or trip on GAB8.

+ Place GABS8 in a location with adequate ventilation to prevent heat buildup and prolong the life. Do not place GAB8 near heat sources, or
in a place subject to direct sunlight, excessive dust, or mechanical shock.

« If the GABS is rack-mounted or wall-mounted, ensure that it is securely attached according to the manufacturer's instructions.

» Maintain records of your purchase and warranty information. If you encounter problems or have questions, contact the manufacturer's
customer support for assistance.

Connectors & LED Indicators Layout
GABS8 Modules

1. Power Supply

GABS supports a wide voltage range of 15V to 30V. It's crucial to connect
a compatible power source within this voltage range to ensure the board
functions correctly. For the best results, a 24V switching power supply is
recommended. Refer to [Page 7] of the documentation for specific power
supply recommendations.

2. Audio Output

Features a 7.3 speaker configuration, providing audio output for gaming
and entertainment needs.

3. Control

"SHDN" and "MUTE" pins operate on an active low basis; shorting them

to GND triggers shutdown or mute mode. 1. IC Working Indication LED - GAB8 Power-Up:

4. USB Audio llluminates when power input is connected to GAB8. With the TPA3244
GABS8 can function as an audio input for the 7.1 USB UAC2.0 codec IC, the illumination of the LEDs indicates that all five ICs are functioning
internal circuit. This feature allows to connect a wide range of audio properly, confirming the presence of signals and outputs in the amplifier.
sources and supporting audio with 24-bit depth and a sampling rate of 2. FAULT & CLIP LED - System Protection:

48,000Hz, providing studio-quality audio. Signals protection mode to system control devices. Any fault resulting in
5. Fan device shutdown is indicated by the FAULT LED. The CLIP LED also

You can connect the fan to a designated port. The fan will activate when illuminates when the IC junction temperature exceeds 125°C.

the heatsink temperature reaches 45°C, ensuring optimal performance, 3. USB LED - Connection Status:

especially during extended use or when operating GAB8 at peak power  llluminates to indicate USB connection status. The LED lights up when
levels. the USB-C connector is connected to the PC.

@ CAUTION: GABS8 does not provide reverse polarity protection. Therefore, extreme caution must be exercised to ensure correct polarity during
connection.Permanent damage caused by reverse polarity will not be covered under warranty.

Specifications are subjected to change without any further notice. Copyright © 2023 by Wondom Audio Technology. All rights reserved.
For more information please visit www.wondom.com
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Ports & Control Layout
Connecting the GAB8

Wire Kit - Power Cable

Please note that this cable is not
included as a part of the cable
accessories. However, you have
the option to purchase as part of
an accessory bundle. Refer to
[Page 7] for information on this
cables.

Wire Kit - Audio Output

Please note that this cable is not
included as a part of the cable
accessories. However, you have the
option to purchase as part of an
accessory bundle. Refer to [Page 8]
for information on this cables.

JST PH 4 Pin Cable

Please note that this cable is not included as a
part of the cable accessories. These cables are
considered standard items and can be
purchased separately from various retailers or
suppliers. However, you have the option to
purchase as part of an accessory bundle.

Refer to the figure for a
visual representation of
the fan connector and the
correct orientation of the
cable's positive and
negative wires.

—————

e [—

Al

Wire Kit - Fan Cable

USB Type-C Cable Details about the cables included
Please be aware that certain cables, while asaccessories with this product can
essential for use with this product, are not be found in the appendix section.
provided as part of the cable accessories. Refer to [Page 9] for information on
These cables are considered standard items this included cables.
and can be obtained separately from various retailers

or suppliers.

Electrical & Audio Performance Parameters
GABS8 Electrical Performance Parameters

Efficiency 10x50W @24V, 40hm, 1kHz

Minimum Load Impedance Floating may lead to EMI issues 3 4 16 Q
Nominal Power Requirement | 24V power supply recommended 150 350 750 w
Operating Voltage 4Q or higher, if resistance 3Q), use 20V or less 15 24 30 \'
Standby Power SHDN short to GND, Signal detected@24V, 0.13A - 3.12 - W
Idle Power MUTE short to GND, Signal detected@24V, 0.53A - 12.7 -

Power Consumption 1/4 of max output power @4Q,1kHz,24V - 240 - w

GABS8 Audio Performance Parameters

Parameter Conditions Min. | Typ.

Output Noise Level A-weighting, USB connection activated L&R - 169 - uVv

SNR 10x50W@40hm, A-weighting - 101 - dB
1W@4Q, 1kHz, / CH - 0.18 -

THD+N 10W@4Q, 1kHz, / CH - 0.14 - %
50W@40, 1kHz, / CH - 0.69 -

DC Offset - - 10 - mV

Specifications are subjected to change without any further notice. Copyright © 2023 by Wondom Audio Technology. All rights reserved.
For more information please visit www.wondom.com
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GABS8

Speaker Configurations

Location of Each Speaker

7.1-Channel Speaker System

5.1-Channel Speaker System

FR
SUB R 08
O Ol Cl
CEN
SSL Iul [SSR] [SSL] l&l SSR
\/ i

Note: When you connect only one rear speaker, place the rear speaker directly
behind the listening position.
As the subwoofer (SUB) does not emit highly directional signals. you can place it wherever you want.

Names And Function of Each Speaker

Abbreviations used Speaker Name Functions

FL Front Left Speaker Produces stereo sounds

FR Front Right Speaker from front left/right channel

CEN Center Speaker Produces vocal sounds from center channel
SSL Side Surround Left Speaker Produces sounds from side surrounds

SSR Side Surround Right Speaker left/right channel

RL Rear Left Speaker Produces sounds from

RR Rear Right Speaker rear left/right channel

SuUB Subwoofer Produces LFE (low frequency effect) channel

sounds and reinforces bass parts of other channels

Speaker Configurations

7.3-channel speaker system Subwoofer

Subwoofer

e‘@

Side Rear
.y ) Front speakers CEN Surround speakers speakers
Prior to connecting any cables,
ensure that the pqwgr cablg 1S @@%3 *If you connect only one rear speaker,
not connected. This is crucial for —

safety during the setup process.

connect it to the L (+/-) terminals.

@Tﬂ ET@

| legge]ogpe {@Tﬂ g

*Before attaching speaker cables
to the speaker terminals, double-
check that wires from the speaker
cables are not in contact with
each other. This precaution

helps prevent electrical s [«
interference and ensures
proper connectivity.

o) o) (o) -, (i) (i

Note: A 7.3 system consists of seven main speakers (Front Left - FL, Center - CEN, Front Right - FR, Side Surround Left - SSL, Side Surround Right - SSR, Rear Left -
RL, Rear Right - RR) and three subwoofers. In this configuration, each speaker should be connected individually to the audio source using appropriate wiring connection.
Additionally, three subwoofers are employed for enhanced bass performance. In contrast, a 7.1 audio system includes the same seven main speakers as the 7.3
configuration, but it utilizes only one subwoofer dedicated to handling bass frequencies.
/ NOTE: To configure your audio system for a 5.3 speaker setup, it's important to make specific adjustments. You will need to remove the Rear Left (RL) and Rear
D Right (RR) speakers that are present in a 7.3 system. Please ensure that you make secure and proper wire connections from the connector to each speaker in
your chosen configuration to optimize your audio setup.

Specifications are subjected to change without any further notice. Copyright © 2023 by Wondom Audio Technology. All rights reserved.
For more information please visit www.wondom.com
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Speaker Configurations
Connecting to 7.1 Surround System and Setting up an 8-Channel Multi-Audio System:

Connecting Hardware: Connect the GAB8 amplifier to your PC's USB Type-C port using a Type-C cable. Plug in the power cable to the
GAB8 amplifier and connect it to a power source to ensure the amplifier has power. Connect the speaker cables from all 8 speakers to their
respective channels on the GAB8 amplifier to maintain audio balance.

Configuring Audio Settings: Right-click on the speaker icon in the Windows taskbar or go to the Sound settings in the Control Panel.
Select "GAB8 WONDOM'" as the playback device. Click on "Configure" under the GAB8 WONDOM device. In the Configure window, select
"7.1 Surround" from the sound format dropdown menu to configure audio output for 7.1 channel surround sound. Test audio through your
PC to ensure that sound is coming from all 8 connected speakers. Under "Advanced sound options," select 24-bit, 48000 Hz Studio Quality.
Enabling 8-Channel Multi-Audio in Audacity:

Open Audacity: Launch the Audacity audio editing software on your

computer.

Enable Advanced Mixing Options: Click on the "Edit" menu at the
top of the Audacity window to reveal a dropdown menu. From this
menu, select "Preferences." This will open the Audacity Preferences
window. Inside the Audacity Preferences window, look for the
"Import/Export" section in the left sidebar. Within this section, you will
find various preferences related to importing and exporting audio files.
Locate and tick the checkbox labeled "Use advanced mixing options."

Enabling this option is crucial for working with multiple audio channels = .
effectively. _

Prepare Your Audio File: Before you can enable 8-channel multi- =5 M

audio, you need to have an audio file with 8 separate audio tracks or
channels. Ensure that your audio file is ready for importing into
Audacity.

Import the 8-Channel Audio: Go back to the main Audacity window.
Use the "File" menu to select "Import" and then "Audio." Locate and

select your prepared 8-channel audio file from your computer's
storage. Audacity will import this file, recognizing it as an audio track
with multiple channels.

Configure Each Channel: After importing the audio file, you will see

it represented as a single track in Audacity. Click on the dropdown
arrow near the track's title to reveal the individual channels or tracks.

You should see all 8 channels listed separately. Configure each
channel according to your preferences. You can adjust volume levels,
apply effects, or make any necessary edits to individual channels.

[oomoomoos:

Export as WAV: Once you have configured the channels to your satisfaction, it's time to export the audio as an 8-channel WAV file. Go to
the "File" menu and select "Export" and then "Export Audio." Choose a location on your computer to save the file and provide a name for it.

Select the Appropriate Format: In the export settings dialog, make sure to save as type “WAV (Microsoft)” and select on encoding
dropdown "Signed 24-bit PCM" as the export format. This format is suitable for preserving high-quality audio. Click the "Save" button to
confirm your export settings and save the audio file.

Playback in Windows Media Player: Once the 8-channel audio file is saved, you can open it in Windows Media Player or any other
compatible media player. When played, each channel will be heard separately, providing an 8-channel audio experience.In this setup, it's
important to note that all speakers will act as full range, capable of reproducing the entire audio frequency spectrum,

NOTE: Multi-audio system typically requires a specific number of speakers to match the number of audio channels. However, if the you has only 2 or 3 speakers,
you can still work with limitations to enjoy multi-audio content.In Audacity, identify the channels or tracks in the audio content and assign them to the available
speakers as per the your's preference. For example, if there are 5 audio channels but only 2 speakers, you can assign 3 channels to the first speaker and the
remaining 2 channels to the second speaker. Audacity provides the flexibility to customize channel placement.

NOTE: You can also export a track into Audacity and set their preferences for each channel to play 7.1 LPCM, allowing for further customization of the audio

D/ playback. After importing the audio file, you will see it represented as a single track in Audacity. Click on the dropdown arrow near the track's title to reveal the
individual channels or tracks. Ensure that you have 8 channels available for playback. These steps should help you set up and configure your GAB8 amplifier
for 7.1 surround sound on your PC.

Specifications are subjected to change without any further notice. Copyright © 2023 by Wondom Audio Technology. All rights reserved.
For more information please visit www.wondom.com
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Accessories
Supplied Optional
Accessories Accessories
[ Audio Output - USB Type C JST PH 4 Pin Universal Wire
ponentatlo Cable Clip Cable Connector
Usage: Usage: Usage: Usage: Usage: Usage: Usage:
Dissipate heat from Audio output for Connect to Secure and prevent Control function. Simplifies the Mounting and
the GAB8's heatsink, gaming and compatible power any unintended connection of securely holding the
ensuring optimal entertainment needs. source. movement of the Length: GAB8's audio output GABS in place.
performance during USB Type-C cable. The cable length cable to individual
extended use. Length: Input: may vary and speaker cables. Size:
200mm=+10mm Voltage range of USB Type C depends on 6.0"x4.5”
Size: 15V to 30V Cable Size: your specific Size:
60x60x10(mm) <@5mm requirements. 38.4mmx13.4mm
Length: x14.5mm
Wire Length: 500mm+50mm

290mm=+20mm K j \ j k

AN AN AN /)

Warranty Terms and Product
Usage Restrictions

Wondom products come with a one-year warranty starting from the
date of purchase. Customers are responsible for the cost of returning
the goods to the seller, and by making a purchase, you agree to this
condition. Due to the nature of DIY products, visible damage or use on
screw holes or tinning of solder pads directly invalidates the warranty.
Damage caused by the use of incorrect power sources, such as
exceeding the specified voltage range or reverse polarity, is not covered
under warranty. All Wondom products undergo thorough testing before
shipment. We do not accept bulk returns after a bulk purchase. If you are
unsure of the quantity you need, please purchase the appropriate
quantity as needed. All Wondom products are intended for DIY use only
and do not support any industrial applications. The rated operating
temperature range is -10-50°C.

Distributed by:

e;U RE

electronics

Sure Electronics Co., Ltd.

Professional Industrial Audio Solution Provider v- _':'l“ '
3F, Building F6, No. 9, Weidi Road, :#Er = *
Xianlin, Qixia Dist., Nanjing, China. o k:" .
+86(25)8526-0046 | info@sure-electronics.com I JE ®,

To view our products and purchase,
please visit our website:
store.sure-electronics.com

Designed by:
AR\
WONDOMX

Wondom Audio Technology

— Have Fun with Us —
58-7-2, Jalan Cantonment,
Wisma Fortune Heights, 10250, Pulau Pinang, Malaysia
+60(4)2189323 | info@wondom.com
(Please use phone calls or email instead of WhatsApp
or iMessage.)

www.wondom.com

Purchasing Rights

When you're considering buying our product in large quantities, here's
what you need to know:

Bulk Purchase Rights: The number of products you can buy at once is
determined by your single purchase, not your total annual purchases.
Customization and Pricing: If you wish to customize our product, the
options and costs depend on the quantity you purchase in a single
transaction.

Retail Purchases: For individual purchases, you can only buy our product
through our authorized distributor platforms. Please note that the listed
prices on these platforms may change over time.

Bundled Pricing for 100 Units: When you buy a minimum of 100 units in
one transaction, you may qualify for a special bundled price for that
quantity.

Customization for 500 Units or More: If you're planning to purchase 500
units or more, you have the option to customize various aspects of the
product. This includes changes to the product's appearances, such as
color, size, logo, cable length, and packaging materials. Additionally, you
can customize the firmware by altering the product string. We also offer a
range of services, which encompass wire kit, panel, cabinet, and mount
bracket design. To explore these customization options further, please
contact us via email for detailed information and to discuss your specific
requirements.

Standard Price List: For orders of 500 units or more, you can request our
standard price list by reaching out to our customer support.
Pricing for Bulk vs. Bundled: It's important to note that the price for
buying in bulk is not significantly different from the bundled price for 100
units.

Origin and Design
Location

All Wondom products are designed, manufactured, assembled, and
shipped from China. The products' country of origin is China. We do not
provide any services for sales, shipping, or manufacturing from other
regions.

Specifications are subjected to change without any further notice. Copyright © 2023 by Wondom Audio Technology. All rights reserved.
For more information please visit www.wondom.com
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